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Module 2, Lesson 5 

PowerPoint Pro 3.0: Table Insertion and Formatting 

Welcome to our next lesson in this second module of the PowerPoint course. We're going to go 
into table insertion and formatting here.  

So I'm going to start by telling you a little bit about when you use tables, why they are useful in 
PowerPoint, and also showing you some examples from real bank presentations. Then we'll get 
into the actual insertion and formatting of tables and some of the key shortcuts and principles 
there.  

And then, for your exercise, you will create and format the Preliminary Management 
Assumptions table. Now, I have already created a slide here, but, as you can see, it is very much 
empty right now. If you pull up the reference slides and go to the fifth slide here, you will see 
the table that we're using on this particular slide. So you will be creating something like this. 
You don't have to enter all the text, or type in all the text, or anything like that. But I want you 
to get some practice with actually creating the formatting and the overall shape and style for 
this table. 

Let's get started with when tables are useful. Tables tend to be most useful in PowerPoint when 
you want to display a lot of text in a more interesting way, and you also don't want to deal with 
annoying alignment or distribution issues when you're doing this.  

[01:05] 

The advantage is that if you use a table in PowerPoint, it handles all the alignment, distribution, 
spacing, and so on for you. So you don't have to go through this exercise where you select 
everything in a row and distribute it or try to align it to some other shape on the left-hand side 
in the middle. All that is handled for you, and you don't really have to think about it as long as 
you set up the settings consistently for the cells. 

One common use case here is laying out the assumptions for product growth or for valuation 
methodologies. And if you take a look at the reference slides and you go to slide number four, 
this is a good example. This is actually a bit of a timeline as well, but you can see that we're 
listing the company's different products and explaining whether they are included in the 
valuation or not here. 
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We also do something similar for explaining how we calculated the weighted average cost of 
capital, or WACC, and we're using a table for this. If you look at the full pitch book presentation, 
you'll get even more examples of all this. 

[01:58] 

Another use case is summarizing the terms of a transaction or potential transaction visually or 
at least more visually than simple text. So if you go over to this reference presentation for 
Morgan Stanley, where they're analyzing or explaining this offer from Thoma Bravo, this is 
another good example of a table. Technically, they could write all this text using simple bullet 
points, and they could just say Price and then give the text $87.50 per share after it. But by 
listing it in a table like this and varying the colors between both portions, it helps to make the 
information stand out a little bit more, and that is why they are doing this here. 

And then a third use case is creating timelines for product launches or deal processes or 
anything else like that. And you can see many examples on the reference slides or at least the 
one example that we have. But in these presentations, there are many other examples of this. 

[02:51] 

I'll go to this Lazard presentation Project Salamander right here. And if you scroll down, you can 
see one example very similar to the one that we're using on slide number four, where they give 
the expected approval dates and whether or not they're in the valuation. And then if you scroll 
down again, you can see this Illustrative Process Timeline. They're almost certainly using some 
type of table or combination of tables for this just from the way all these cells are precisely 
aligned. If you think about it, doing something like this with individual shapes would be 
incredibly complicated and annoying and time consuming because of the amount of alignments 
you'd have to make. Similarly, this part at the top is probably also either a part of this table, or a 
separate table, or something like that. 

So these are a few examples of how you use them. The main reason to not use separate shapes 
is, as I was just saying, inserting, aligning, and distributing them gets very complicated when 
you're trying to make a chart that looks like this. You might be able to solve some of these 
issues with VBA and macros and outside tools, but you won't be able to solve all of them. For 
example, editing is quite annoying when you have all these separate shapes because you have 
to click into each one individually and go to F2 or click on the text and try to go in like that and 
edit it. In a table, it's much easier. You can navigate between cells more efficiently and quickly. 

[04:09] 
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In terms of downsides for tables, there are a couple to note. One issue is that copying text to 
and from a table can be quite cumbersome. So going back to the reference slides here, if you 
look at a table like this, actually creating this was not that difficult, but it took some time to 
copy and paste in all the text. And I actually ended up retyping all the text here because, yes, 
we had this in the accompanying Excel file, but the issue is that there wasn't really a great way 
to copy it from all these different areas of Excel into this table. So I ended up just retyping this 
for the most part. If you're trying to copy text from a Word file or a Notepad file, there's no 
easy way to tell PowerPoint that you want to copy it across all the cells in the table. So that is 
one potential downside here. 

[04:58] 

Another downside is that you can't easily align table cells with other objects. And you saw this 
before with one of the exercises we went through with the Ninja Lines earlier, where going 
back to the reference slides, let's pull this up, with these check marks and these X's over here, it 
wasn't especially easy to get these aligned within these table cells. So that's another potential 
downside. Tables do not interact well with other shapes on the slide, especially ones that are 
directly over them. 

And then another issue is that if you want to go back and forth, so let's say you have a table and 
then you want to break everything into separate text boxes or shapes, or you want to do the 
opposite, you have separate shapes or text boxes and you want to turn them into a table, there 
isn't really an easy way to do this in PowerPoint built in. Again, many of these issues are fixable 
if you have the right macro, or VBA code, or the right outside tool or service installed. And we 
will go over those later in this course. But I'm just pointing out that these are some of the built-
in problems if you do not look at these outside tools and services. 

[06:03] 

Let's now go to the process of inserting and formatting tables. And to illustrate this, I am just 
going to pull up the reference slides here. And I'm just going to go to the last reference slide, 
the one with all the formatting tools and tips. And I'm just going to drag these over because I 
want to focus on inserting a table in the main area right here.  

So the key shortcuts here are as follows. Alt, N, T to insert the table. Once you have the table 
inserted and you click on it, you can click on the whole thing or just a specific row or column or 
cell. You can go to Alt, JT for the Design tab and then Alt, JL for the Layout tab. And you can use 
Tab to move to the next cell or insert a row at the end of the table. You can also use Shift + Tab 
to move to the previous cell. 
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So let's take a look at what this might look like. I'll press Ctrl + F1 just so you can see the whole 
Ribbon menu here. If I go to Alt, N for Insert and then T for table, I have a couple options. I 
could just insert a table by manually specifying the number of columns or rows, or I could go up 
and I could use this device to sort of draw the table on a slide. Or I could even use this shortcut 
D to draw our own table. 

[07:10] 

But I would say in 90% of cases, you either insert a table and you specify the number of rows 
and columns, or you use this part up here to insert a table with the exact number of rows and 
columns you want. So let's do that. 

Now, once you have a table that's inserted like this, just like there is an edit mode with shapes 
and text boxes, it's similar for tables. But it doesn't quite work in exactly the same way because 
these are essentially a bunch of smaller shapes that are all stuck together. So if I click on a table 
cell here, I'm already in edit mode. If I click outside of it and I am not in any particular cell, then 
by default, when I start typing text, it will go to the top left corner, and I'll see the text right 
there. So there isn't quite the same separation between edit mode and navigation mode that 
you'll see with many other objects in PowerPoint. 

[08:01] 

If I go to the Table Design menu Alt, JT, I can apply one of the many built-in PowerPoint 
formats. These change over time, and they'll be a little bit different depending on the version of 
PowerPoint that you're using. But all of these can be useful to varying degrees. Most banks will 
tend to have their own formats that you can use for these, and you should be able to import 
them pretty easily or at least import the colors that they're using. But you do have a choice with 
all these different formats. 

For now, let's just pick a pretty standard blue-looking one. I'll pick this Medium Style 1, Accent 1 
right here. And we have that. 

Now, in terms of these different options, Alt, JT for Table Design, as you'd expect, it controls 
things like the border colors and the types of borders and which borders you want to apply. You 
have diagonal borders, top, bottom, left, right borders, inside horizontal and inside vertical 
borders. So there are many different options here. There are also many different options for 
the theme colors. 

[09:00] 
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Just to show you a few useful things though, let's say that I highlight this whole area down here 
and I decide to say that, you know what, I now want to see some vertical borders in this table 
rather than just the horizontal borders. If I go to Alt, JT and then I go to Borders, and then I 
select the Inside Vertical Border right here, now we get some vertical borders.  

And before doing that, generally speaking, what you want to do is select the type of style over 
here, right where there's the Pen Color. You can select the Pen Color from here. So we could 
change it to some other color of blue, or green, or purple, or something like that. 

We could change the design up here to some other type of border, for example. And then I can 
go to Borders, and I can click on Inside Vertical Border. And now we get it in the style that we 
want it there.  

So you have a lot of control. You can apply this to the entire table, or you can apply it to just 
one column or just one row. You also have these options for Banded Rows right here. So you 
can enable or disable this, and you can even enable or disable the header row up here in case 
you want to title the table as something else. 

[10:05] 

Now, in terms of navigation around within tables, as I said before, you can press the Tab key to 
move over to the next cell, and then you can press Shift + Tab to move back to the previous cell. 
So these are some useful navigation shortcuts. The arrow keys also work if you want to move 
up a row or down a row, or you want to move left or right to a column.  

I think probably the most useful shortcut, though, is that when you move to the very end, the 
very bottom right cell of a table and then you press Tab, it actually inserts another row for you. 
Now, the downside is that you now have to press Tab or just go to the right using the arrow 
keys, but if you press Tab again right here, you get another row right there. 

So these are some quick navigation tips. If you go to the Layout tab, Alt, JL, there are a lot of 
options here for inserting a new row, inserting a column to the left or to the right, or inserting a 
row above or below where you currently are. You can also delete columns, rows, or the entire 
table from right here.  

[11:03] 

So these are all potentially useful, but normally you don't end up using them all that much 
because when you insert a table, you usually have an idea of how many rows or columns you're 
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going to need. You might change it by one or two, or you might end up deleting some of it, but 
you're probably not going to be inserting or deleting rows or columns all the time. 

Some of these other shortcuts, like merging and splitting cells, distributing rows and columns, 
we'll get into in the next lesson here. I don't want to address all this right now. I just want to 
focus a little bit more on the basic formatting and insertion. 

And then you also have the normal options for the cell margins, which function sort of like the 
interior margins that we looked at before with the Alt, 5 shortcut, except these don't apply to 
the entire shape. These just apply to all the cells in the shape. So if I change this to Wide, now 
we have a lot more space. If I change it to None, we have absolutely no internal margins. And if 
I change it to Narrow, we get simply narrower margins on the top, the bottom, the left, and the 
right. 

[12:04] 

I usually keep this set to Normal and have modest top and bottom margins and slightly bigger 
left and right margins. But you can obviously change this to whatever you want. 

So these are some of the key shortcuts and commands with inserting and formatting tables. 
Everything you learned about shapes and text boxes also applies here. So you still have the 
internal margins, but they're applied on a cellular level to individual cells. You still have 
horizontal and vertical alignment. You can still change the font.  

Also, I want to point out that you don't have to go to the Design or Layout tabs up here in the 
Ribbon menu. You can potentially select an entire area of a table like this, and you can go to 
something like Alt, 3 for the Fill Color and you can just select a new fill color from this. And this 
will override whatever settings were set up in the Table Design or Table Layout tabs in the 
Ribbon menu.  

Similarly, with the font color, you can just select everything here. And if you say, "I want black 
font color," you can go to Alt, 2 and change it to black. And again, this will override the settings 
that you previously set up in the Table Design and Layout menus up there. 

[13:10] 

And as I mentioned, you can set these for the entire table and also for individual cells. 

So that's a little bit about inserting tables and the key formatting design and layout commands. 
Let's now go to your exercise and talk about what you need to do here.  
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So I want you to create the Preliminary Management Assumptions table from the reference 
slide file. And in case there's any confusion, this should be slide number five in the reference 
file. 

In the Before file here, I have already given you the shell of the slide layout. So I've given you 
the header up here at the top. You also even have the footer text. But you don't have the table 
in the middle of the slide, and that's what I want you to create. Don't type in all the text or even 
paste it in. It's a waste of time. Just type some dummy text, like "XXX" or "Test123" or 
something like that. 

[13:57] 

Focus on the table format, the correct number of rows and columns, the spacing, the margins, 
the borders, the fonts. You don't have to get it exactly perfect with the reference slide version, 
but try to get it as close as possible. And if you're in any doubt, do what we've been doing and 
just go to the reference slide, look up the formats that we're using there, and then apply them 
to the version that you are going to create. So pause this video right now. Try this yourself. 
When you're done, come back, unpause it, and then we'll go through this together. 

Okay, good. So first let's start by counting how many rows and columns in the table we're going 
to need here. As far as we can tell, there are one, two, three, four, five, six, seven rows, and 
then there are one, two, three, four, five, six, seven, eight, nine columns, so nine columns, 
seven rows. Let's start by inserting a table. And I'll actually press Ctrl + F1 so you can see the 
Ribbon menu here. I think it is helpful to see this for this type of formatting exercise. 

[14:59] 

Alt, N, T for table. And so we can see here that if we want seven rows, we can certainly go down 
and do that, and then we can also get the nine columns right here. So let's just insert it like that. 
And so we have this. And let's just put it down. And I should also press Alt, W, S at this point to 
get our drawing guides on screen. That'll also be really helpful as we go through this exercise 
because we want this table to span the entire width of this screen. So let's drag this over and 
then let's drag this down to the bottom so we have as much screen real estate here as possible. 

Let's go and look at this reference slide once again and try to get some of the formatting here. It 
seems like overall, if I just press Ctrl + F1, we are using the Calibri font, and we're using size 12. 
We have bold text in white up here. And it seems like we're using the same dark blue 
background color that we've been using throughout the presentation. It looks like the light blue 
background color here is slightly different. So let's get some of these set up.  
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[15:59] 

And before I even do this, I also want to type in some dummy text to all these cells. Let's select 
this, Ctrl +C, and then let's use the mouse to highlight everything in the table. And then Alt, E, S 
and I can just paste this as Unformatted Text just so we have it somewhere in our table. 

Let's start in the top row. And there are a couple ways we could do this. We could go to the 
Table Design right here, so Alt, JT. And for the Shading, I could select the dark blue color that 
we've been using, and that would be perfectly fine. So let's actually do this one that way. 

For the one below this, we don't know exactly what this is. So let's go to the reference slide and 
try to get the color from right here. I will select this whole top row, go to Alt, 3, and then go to 
More Fill Colors. And it seems like the RGB code is 233, 235, and 245. So let's go to our table 
right here and enter this. So I'm going to select everything here and then I can just go to Alt, 3 
to do this. And let's go to the More Fill Colors right here, Custom, and then 233, 235, and 245. 
And now that is looking better. 

[17:07] 

I think probably the easiest thing is to go back to the reference slide and note that it seems like 
everything here is centered in the middle of each cell, and it also appears to be in the middle in 
terms of the vertical alignment. So we need center horizontal alignment and middle vertical 
alignment. To do this, we could just select the whole shape as I'm doing here, Alt, JT. And we 
don't see any options for the alignment here, so let's go to the Layout tab instead, so Alt, JL to 
get to that. And then I could just go to AC for center. And then for the vertical alignment, Alt, JL 
and then C, which you can see right here for Center Vertically. And so that appears to be a bit 
better. 

In terms of other things, if we go here and look at this, this seems to be using size 18 font, 
which we'd say is probably too big. It doesn't match up at all. If I go to Alt, 7, I'll just change this 
to 12. I could have used the other shortcut to move these down incrementally, but it would 
have taken more time. So I don't think it's really worth the effort in this case. 

[18:05] 

Let's go to the reference slides once again and see what else we have to do. So it looks like the 
white borders here, the vertical interior borders are fine. They seem to match up with what we 
have pretty closely. If we just zoom in, there might be a small difference here, but I don't think 
it's noticeable. So we don't really have to fix anything there.  
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However, there are some issues with the other types of borders here. Specifically, it seems like 
we do have some very faint vertical borders if you zoom in really close and look at these. So I 
think that's fine, but the horizontal borders here are clearly different. Now, we don't know 
what their exact format is, and it's actually a little bit hard to tell. But what we can do here is 
just go back to this table, and for now we will keep these vertical borders, but what I want to do 
is change around the horizontal interior borders a little bit. 

[18:54] 

So I'll select everything here, and then I will go to Alt, JT for Table Design. I will go to B for 
Borders. And then, for now, I will just say no borders at all anywhere here. And then I'll go back 
and I will do the same thing, so Alt, JT after selecting everything where I want the borders, go to 
B for borders. And we need to change the Pen Color here so that we get a blue color instead. 
We don't know exactly what it is, but for now I will just pick one of these blue colors up here 
and maybe we can fix this later if we can figure out the exact color. For the style, we could pick 
any of these, but I'll pick the dotted or the dash style up here rather. I'll keep this set to 1 point. 
And then for actually inserting the borders, let's go to Borders and then let's go to Inside 
Horizontal Border and click this. And now we get this in place. 

Now, we can tell very quickly by looking at this that this is not quite what we had here. It seems 
like something is different. It might be the weight. It might be the color being darker. It might 
be that we have a slightly different dash style. But I don't think it really makes a huge 
difference. 

[20:04] 

And then looking at the vertical borders, it looks like, for this one, although we have them here, 
they are very, very faint. And it seems like they actually match up pretty well to what we have 
here. So I don't think we need to change this really. I think the main thing is we could try to play 
around and get a more exact match with these interior horizontal borders, but I don't really 
think it's worth the time and effort to do this here. I would say this table looks to be good 
enough for our purposes. 

If we go in, we can make sure this is bold at the top. And then on the left-hand side, we also 
want the first column here, which lists all the information, to be bold. So let's go down and 
select everything using the mouse, and I'll just press Ctrl + B to make that bold. And we have 
our table. 
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We're at the end. So let's do a recap and summary. I started out by explaining why tables are 
useful. You use them all the time to display transaction and valuation assumptions, to make 
text, especially assumptions in models, appear more interesting. You also use it to display 
timelines and other types of graphs that show the passage of time.  

[21:05] 

The main advantage of tables over shapes and text boxes is that it's a lot easier to align, 
distribute, and edit them. When inserting and formatting tables, the key shortcuts are Alt, N, T 
to insert a table and pick the type and format you want, Alt, JT and Alt, JL for the Table Design 
and Table Layout and all the formatting options there. Everything you learned about with 
normal shapes and text boxes, like the interior margins and the line spacing and all the standard 
shortcuts for changing the fill colors, the fonts and so on, all apply here. And then for your 
exercise, you created and formatted the Preliminary Management Assumptions table on that 
slide. 

That's it for this lesson. Coming up next, we will delve further into tables, and you'll learn more 
about how to distribute rows and columns and also how to split and merge cells and when 
these features might be useful. 

 


